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• Gantogram
• Mrežno planiranje
• Izrada mrežnog dijagrama
• PERT metoda
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Work Breakdown Structure 
(WBS)

Razvijanje strukture raščlanjenih poslova (WBS) 
predstavlja osnovu projektnog menadzmenta. 
Svrha WBS-a je da se identifikuju i rasčlane svi poslovi 
na projektu, do nivoa jednog vlasnika aktivnosti.

WBS se može graditi tako da se počne s najširom 
grupacijom poslova koja se onda razbija na manje celine 
(Top-down metoda) ili obrnuto, da se prvo identifikuju svi 
najmanji zadaci pa  se onda grupišu u veće celine 
(Bottom-up metoda). 
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Work Breakdown Structure 
(WBS)
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Gantogram

Gantt-ov dijagram ili gantogram dobio je ime po Henry Laurecu 
Gantt-u (1861-1919), naučniku i inžinjeru koji ga je i osmislio 1890. 
godine.

Gantogram se prikazuje u koordinatnom sistemu, gde se na 
horizontalnoj osi prikazuje vreme, dok su na vertikalnoj osi 
pojedinačno prikazane aktivnosti s vremenom njihovog početka i 
kraja.

Vremenski interval se odreñuje prema vrsti projzvodnje odnosno 
prema dužini projzvodnog ciklusa, može biti iskazan u danima, 
nedeljama ili mesecima. 
Pogodan je za projekte koji imaju do 30 različitih aktivnosti, odnosno 
kod kojih popis aktivnosti može stati na jedan list papira. 

Pre početka crtanja gantograma, potrebno je napraviti WBS, a 
nakon toga je  moguće formirati tablicu meñuzavisnosti.
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Gantt-ov dijagram

Prednosti:
-na jednostavan i pregledan način 
prikazuje aktivnosti; 

-na jednostavan i pregledan način 
prikazuje trajanje  aktivnosti ;

- lako je  pratiti razvoj projekta.

Nedostatci:
- ne vidi se meñuzavisnost izmeñu 
aktivnosti ;

- ne daje informacije o resursima koji su 
zaduženi za pojedine aktivnosti;

- iz njega se ne može očitati kritični put.
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Mrežno planiranje

Zbog potrebe izbegavanja nedostataka Gantt-ovog 
dijagrama,osmišljen je mrežni dijagram. Osnovni pojmovi tehnike 
mrežnog planiranja su:

• Projekat – predstavlja se mrežnim dijagramom koji prikazuje 
aktivnosti, trajanje i način njihove meñusobne povezanosti.

• Aktivnost – deo projekta, moguće mu je dodeliti trajanje(ti) i resurse 
(ri).

• Dogañaj – trenutak početka jedne ili kraj jedne ili više aktivnosti, 
nema trajanje, već samo vreme nastajanja.

• Fiktivna aktivnost – izmeñu dva dogañaja u tehnici mrežnog 
planiranja može postojati samo jedna aktivnost; ako nastane 
situacija da postoje dve aktivnosti, onda se to prikazuje primenom 
fiktivne aktivnosti.

• Trajanje projekta – izračunava se na osnovu trajanja aktivnosti.

• Rok ili termin – vremenski unapred utvrñen dogañaj.
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Osnovni pojmovi 
mrežnog dijagrama

� Tei- najraniji mogući početak aktivnost
� Tfi- najkasniji dozvoljeni početak aktivnosti
� Tej- najraniji mogući završetak aktivnosti
� Tfj- najkasniji dozvoljeni završetak aktivnosti
� i- redni broj početnog dogañaja
� j- redni broj završnog dogañaja
� t- vreme trajanja aktivnosti
� i-j- oznaka aktivnosti

Primer mrežnog dijagrama
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Metode mrežnog planiranja

Najpoznatije metode mrežnog planiranja su:

• CPM (Critical path method – Metoda kritičnog puta),

• PERT (Program Evolution and Review Technique),

• AON (Activity On the Node),

• PDM (Precedance Diagram Method).
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Izrada mrežnog dijagrama

Ovom metodom se odreñuje najraniji početak aktivnosti. 
Najkasniji početak aktivnosti se odreñuje tako da se 
gleda najkraći put počevši od krajnjeg dogañaja. 
Može se primetiti da kritični put čine aktivnosti kod kojih 
je zazor jednak nuli što znači da svaka promena u 
trajanju izvršenja tih aktivnosti (npr. zbog promene 
raspoloživih resursa) direktno utiče na celokupno trajanje 
projekta.
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Mrežni dijagram
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PERT metoda

Ova metoda služi za procenu verovatnoće da će projekat biti završen do 
zadatog roka. Ona se primenjuje kod izrade rokovnika projekata koji se 
izrañuju po prvi put, tj. kod projekata koji su sastavljeni od aktivnosti koje 
nikada do tad nisu rañene. Svaka aktivnost je definisana sa tri trajanja: 
optimističko (to), pesimističko (tp) i najverojatnije trajanje aktivnosti (tm). 

• Optimisti čko vreme označava vremensko trajanje aktivnosti koje se pri 
njegovom izvoñenju može dogoditi samo pod povoljnim uslovima i vrlo 
srećnim okolnostima. Verovatnoća da će se odreñena aktivnost izvesti u 
vremenu to ili kraćem vremenu iznosi 0,01 odnosno 1%.

• Pesimisti čko vreme označava vremensko trajanje aktivnosti koje se može 
dogoditi samo u vrlo nepovoljnim i nesrećnim okolnostima izvoñenja 
odreñene aktivnosti. Verovatnoća da će se odreñena aktivnost izvesti u 
vremenu tp ili dužem vremenu iznosi 0,01 odnosno 1%.

• Najverovatnije vreme označava vremensko trajanje aktivnosti koje ima u 
praksi najveću pojedinačnu verovatnoću da će se ostvariti, a obično se 
označava sa tm.
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Raspodela verovatno će vremena 
trajanja aktivnosti

Procenjena vremena aktivnosti ponašaju se prema 
matematičko– statističkoj distribuciji, odnosno normalnoj 
distribuciji. Ta distribucija može biti simetrična i 
odgovarati normalnoj raspodeli ili asimetrična, prema 
levo ili prema desno, kako je prikazano na slici.
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Očekivano vreme trajanja 
aktivnosti

Iz zadatog optimističkog, pesimističkog i najverovatnijeg 
vremena trajanja treba izračunati očekivano vreme 
trajanja aktivnosti (µ) i standardnu devijaciju (σ) preko 
sledećih formula:
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PLANIRANJE POMO ĆU PROGRAMA 
MS PROJECT

• Definisanje osnovnih podataka o projektu
– Definisanje datuma početka projekta
– Definisanje radnog vremena i kalendara

• Definisanje aktivnosti, faza i resursa projekta
– Upisivanje aktivnosti projekta
– Grupisanje aktivnosti u faze

– Definisanje zavisnosti izmeñu aktivnosti
– Unos Milestone-a
– Dodavanje WBS strukture

– Definisanje raspoloživih resursa
– Dodeljivanje resursa aktivnostima
– Pregled projekta pomoću izveštaja

– Snimanje baseline projekta

� Praćenje izvo ñenja projekta
– Praćenje izvršenja aktivnosti u procentima
– Uticaj neplaniranog produžetka jedne aktivnosti na ceo projekat
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Definisanje datuma po četka 
projekta 

Jedan od načina kako definisati osnovne podatke projekta je pomoću 
Project guide-a, koji se može uključiti preko View -> Turn On Project 
Guide. U podgrupi Tasks odaberemo prvu opciju, Define the project, 
što možemo videti na slici 

Jedan od načina upisivanja

datuma početka projekta 

je preko menija  Project 
-> Project Information
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Definisanje radnog vremena 
i kalendara

Sledeći korak je definisanje radnog vremena i kalendara. To se 
takoñe može uraditi pomoću Project guide-a tako sto kliknemo na 
drugi korak u grupi Tasks tj. na Define general working times.

Prvi korak je odabir tipa kalendara

gde je potrebno odabrati Standard.

Drugi korak je definisanje radnog
vremena koje je u našem slučaju

od ponedjeljka do petka s radnim 

vremenom od 8:00 do 12:00 i 

od 13:00 do 17:00
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U sledećem koraku pod Change 

Working Time se definiše kalendar. 

A zatim se upisuju neradni dani i praznici
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Četvrti korak je definisati broj radnih sati dnevno, sati nedeljno i 
dana mesečno. To se takoñe može definisati preko menija Tools -> 
Options u fascikli Calendar.

Još je potrebno podesiti neke osnovne 
opcije kao što je željeni format datuma i 
valutu preko menia Tools -> Options u 
fascikli View 
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Upisivanje aktivnosti projekta

     Sve aktivnosti kao i njihova trajanja odreñuju se na početku. Na primer 
prva aktivnost je "Izrada studije izvodljivosti". Pod Task Name upišemo 
ime aktivnosti, a pod Duration njeno procenjeno trajanje gde je data 
defoltna vremenska jedinica no moguće je odabrati i minute, sate, 
nedelje ili mesece. U ovom slučaju trajanje aktivnosti je zadato u 
nedeljama pa se trajanje unosi kao "5,5wk". MS Project za početni 
datum uzima datum početka projekta a datum kraja automatski 
izračunava.
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Grupisanje aktivnosti u faze

Aktivnosti se grupišu u faze da bi 
korisnici imali bolji uvid u složenije 
projekte. Za ovaj projekat definisane 
su četiri faze: "Početno planiranje", 
"Izrada hardvera", "Izrada softvera" i 
"Testiranje i dokumentacija". Faze 
ubacujemo u popis aktivnosti preko 
Insert new task. Da bi se aktivnosti 
grupisale u faze može se koristiti 
Project Guide. U grupi Tasks kliknemo 
na link Organize tasks into phases
gde se pomoću strelica Indent i 
Outdent obavlja željeno grupisanje. 

Te iste ikone se nalaze u alatnoj traci
Formatting. 
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Definisanje zavisnosti izme ñu 
aktivnosti

Ako vreme obavljanja jedne aktivnosti zavisi od druge aktivnosti 
onda su te dve aktivnosti meñuzavisne. Postoje četiri tipa 
meñuzavisnosti:

• Finish-to-start (FS): Datum kraja prethodnog  zadatka odreñuje 
početni datum zadatka koji sledi. 

• Start-to-start (SS): Datum početka prethodnog zadatka odreñuje 
datum početka zadatka koji sledi. 

• Finish-to-finish (FF): Datum kraja prtethodnog  zadatka odreñuje 
datum kraja zadatka koji sledi. 

• Start-to-finish (SF): Datum početka prethodnog  zadatka odreñuje 
datum kraja zadatka koj sledi.
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     Meñuzavisnost možemo definisati na više načina. 

Prvi način je da pokraj svake aktivnosti (koje sledi) u koloni 
Predecessors (prethodne aktivnosti) upišemo broj reda koji sadrži 
odgovarajuću aktivnost tj. prethodne aktivnosti.

Drugi način je preko Task Information u fascikli Predecessors. Tu 
možemo odabrati prethodnu aktivnost iz padajućeg menija sa 
popisom svih aktivnosti .
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Unos Milestone -a

Neki ključni dogañaji u projektu se mogu definisati kao milestone. 
Milestone nemaju trajanje već su to neki važniji trenutci koji služe boljoj 
organizaciji i boljem praćenju projekta.

U popis aktivnosti se milestone unose isto kao i nove aktivnosti samo 
što se za trajanje upiše nula po čemu MS Project automatski prepozna 
taj novi unos kao milestone. U našem primeru dodati su milestone
"Završena izrada hardvera" i " Završena izrada softvera" što se može 
videti.
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Dodavanje WBS strukture

Da bi dodali WBS u projekat moramo uključiti kolonu WBS. To 
činimo tako što kliknemo desnom klikom  na kolonu  kraj koje je 
želimo smestiti, kliknemo Insert column i pod Field name odaberemo 
WBS .

Ovako izgleda kada je
dodat WBS u projekat 
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Definisanje raspoloživih resursa

Dve glavne karakteristike resursa su raspoloživost i trošak gde 
raspoloživost definiše kada se i koliko odreñeni resurs može koristiti, a 
trošak definiše potrebnu količinu novca da bi se resurs koristio.

U MS Projectu se resursi mogu uneti pomoću Project guide-a, u 
podgrupi Resources klikom na Specify people and equipment for the 
project. Naziv resursa upisuje se u koloni Resource Name. Klikom na 
Resource Sheet se dobije popis svih unetih resursa.
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Raspoloživost nekog resursa može se 
promeniti dvostrukim klikom na taj 
resurs čime se otvori prozor Resource 
Information. Raspoloživost se može 
promeniti u fascikli General u tablici u 
koloni Units . Raspoloživost je zadata u 
procentima gde 100% označava da je 
resurs na raspolaganju 8 sati na dan.

U MS Projectu se može definisati 
opterećenje svakog resursa pojedinačno. 

Da bi uneli fiksni trošak prvo moramo 
uključiti kolonu Fixed Cost . To činimo tako 
što kliknemo desnim klikom na kolonu kraj 
koje je želimo smestiti, kliknemo Insert 
column i pod Field name izaberemo Fixed 
Cost
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Dodeljivanje resursa aktivnostima

Resursi se mogu dodeljivati aktivnostima na više načina. Jedan je 
preko Project Guida-a, u grupi Resources preko linka Assign people 
and equipment to tasks. Onda treba odabrati željenu aktivnost i 
kliknuti na Assign resources čime će se otvoriti prozor  gde se 
odaberu pripadajući resursi.

Dodeljene aktivnosti takoñe možemo 
videti na Ganttovom dijagramu
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Pregled projekta pomo ću izveštaja

Pre početka izvoñenja projekta, 
potrebno je pregledati neke 
osnovne informacije o projektu, 
odnosno informacije o rokovima, 
troškovima i resursima. Ukoliko 
neki deo projekta nije prema 
predviñanjima i željama potrebno je 
reorganizovati taj deo projekta. 
Osnovne informacije o projektu, 
kao što su početni i krajnji datum 
projekta, njegovo ukupno trajanje 
te ukupni trošak, mogu se videti 
preko Project -> Project Information
pa klikom na Statistics.
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Podela resursa po pojedinim aktivnostima i 
po odabranom vremenskom razdoblju 
može se videti preko View -> Resource 
Usage
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U pogledu Resource Graph može 
se uporediti zadata i tražena 
raspoloživost pojedinog resursa. 
Ukoliko se zahteva više resursa 
nego što je na raspolaganju  taj 
višak će biti obojen crveno kao 
što se može videti na slici.
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MS Project pruža mnoge mogućnosti izrade 
izvještaja. Do njih se dolazi preko opcije 
Report -> Reports.

Izveštaj o budžetu

Izveštaj Who Does What

Izveštaj o 
radnom 
vremenu
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Snimanje baseline projekta

Da bih imali uvid o izvoñenju projekta mora se uporeñivati stvarno 
stanje u odnosu na planirano. Originalni plan, koji se naziva 
baseline, sadrži osnovne podatke o projektu, kao što su datumi 
početka i kraja i troškovi zadataka i resursa. Baseline možemo 
snimiti pomoću Project guide-a, preko linka Save a baseline plan to 
compare with later version koji se nalazi u podgrupi Track .
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Praćenje izvo ñenja projekta 

Za uspešno voñenje projekta, projektni menadžer mora u svakom 
trenutku znati kako se odvija njegov projekat.
Pravilno praćenje napredovanja i uporeñivanja sa planom daje odgovore 
na sledeća pitanja:  

• Da li zadaci počinju i završavaju kako je planirano, a ako ne koji uticaj te 
devijacije imaju na projekat? 

• Da li resursi troše više ili manje vremena za izvršenje pojedinih 
zadataka? 

• Da li su troškovi viši od očekivanih i da li premašuju ukupni budžet 
projekta?
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Praćenje izvo ñenja aktivnosti 
u procentima

Kada projekat počne potrebno je u odreñenim trenutcima snimati 
napredak. Za primer možemo uzeti da je 10.oktobar 2011. i da se 
sve aktivnosti izvode prema planu. Odemo na Tools -> Tracking -> 
Update Project. Na Tracking Ganttu se može videti procentualna 
završenost pojedine aktivnosti do zadatog datuma kao i 
procentualna završenost faza i celokupnog projekta. 
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Uticaj neplaniranog produžetka 
jedne aktivnosti na ceo projekat

Pošto je malo verovatno da će se celi projekat odvijati prema planu, 
dobro je znati kako će neplanirani produžetak trajanja jedne aktivnosti 
uticati na vreme trajanja celog projekta. Za primer ćemo uzeti jednu 
aktivnost koja ne pripada kritičnom putu.

Neka je i dalje datum 10. oktobar 2011. Uzmimo aktivnost B – "Izrada 
kućišta računara". Da bi produžili trajanje aktivnosti za recimo dve 
nedelje prvo selektujemo aktivnost B, zatim odemo na Tools -> 
Tracking -> Update Project i podesimo opcije. 

U statistici projekta se može uporediti 
planirani kraj projekta odnosno ukupno 
trajanje sa stvarnim 
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Hvala na pažnji

Kontakt:

Kooperativni trening centar – CTC Kragujevac
Univerzitet u Kragujevcu

Prof. Dr Vesna Mandić, Koordinator CTC Kragujevac
Sestre Janjić 6

34000 Kragujevac
Tel. 034 501 201
Fax. 034 501 901

E-mail: ctc@kg.ac.rs
Url: www.ctc.kg.ac.rs
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